
Fledermaus Software Release Notes 
 

Version 6.7.0 7 January 2008 
 

 
This release adds a few new features but is mostly focused on improving existing 
functionality and incorporating a number of bug fixes.  
 
Fledermaus Standard Version: 
 
Avggrid:  
 

- Two new gridding algorithms have been added: a deep surface, which 
selects the deepest record in each bin, and a root mean square (RMS) 
surface, which calculates the RMS value for each bin.  

 
Dmagic:  
 

- Two new algorithms have been added for slope calculations as well as 
additional options for the existing algorithm: 

 
o The pre-6.7.0 algorithm is now available by selecting “Simple”. You 

also now have the choice of choosing how the final slope is chosen, 
either based on a direction, the maximum/minimum of all eight 
slopes, or the average of the eight. 

 
o The “Fitted Plane” option uses the algorithm from Burrough [see 

reference] which fits a plane over a 3x3 window of cells. This is the 
same algorithm used by ESRI software for slope calculation. 

 
  Burrough, P. A. and McDonell, R.A., 1998. Principles of Geographical  
  Information Systems (Oxford University Press, New York), p. 190. 
 

o To improve slope calculations when directionality is a strong 
concern, the “Balanced” algorithm has also been added, which 
centers the slope calculation over the middle of the cell. This 
algorithm also allows the sign of the slope to be preserved, which is 
improves the calculation of a 2nd derivative slope calculation.  

 
FMCommand / Cmdop: 
 

- A new command line applet, sdtodxf, has been added to directly export a 
Fledermaus 3D line file to DXF format.  

 
 



Fledermaus:  
 

- A new option has been added for projecting S-57 data to Survey 21 when 
being imported into Fledermaus.  

- DXF/DWG Import capability has been added to the 64-bit Windows 
version. 

- Animated Surfaces are now saved directly in the scene file. Previously 
only a link was saved to the external SD file.   

- Fixed a bug with adding a single point in a scene file.  
- Fixed a potential crash when importing point files with labels. 
 

 
Fledermaus Professional Version:  
(Includes everything from standard) 
 
 
PFMDirect  
 

- Increased the maximum number of input files in a single PFM to 8192. 
- Fixed a bug with soundings flagged as ‘designated’ being incorrectly 

designated when importing HDCS data.  
- Fixed a problem when importing ASCII files with lines larger than 256 

characters.  
- A number of fixes for reading and exporting BDI format files have been 

implemented.  
 
Fledermaus 
 

- Added a new option to create a sounding density surface from a PFM data 
set. This surface is based only on accepted records in contrast to the built 
in PFM density surface which includes both accepted and rejected 
records.  



 

 
Version 6.5.1a 17 September 2007 
 
 
This is a maintenance release is which fixes a number of smaller issues. In 
addition a 64 bit Linux version of the software has been added to the list of 
standard release platforms. 
 
Fledermaus Standard Version: 
 
General:  

- Improvements to the Linux installer to better integrate the software into 
various Linux distributions. 

 
Imageviewer: 

- Improved the floating point GeoTiff writer for improved compatibility with 
other 3rd party applications.  

 
Dmagic: 

- Surfaces can now be exported as floating point GeoTiff files (the 
exportsurface command line application was also updated to add this 
feature). 

- Fixed a bug under Windows that caused a crash when importing 
GMT/NetCDF surface files. 

 
 
Fledermaus Professional Version:  
(Includes everything from standard) 
 
PFMDirect: 

- The MPA tide format reader was changed to interpret months in the range 
of 1-12 instead of 0-11. 

- A problem appending Shoals TOF files to a PFM was fixed.  
 
Fledermaus: 

- Added support for writing Bathymetric Attributed Grid files for Linux 
platforms in addition to Windows. 

 
Crosscheck: 

- Fixed a memory leak. 



Version 6.5.1 12 August 2007 
 
 
This release is primarily a maintenance which contains a several important 
PFM/Cube related fixes but also includes several new features. In particular the 
Space Navigator device now works on the Macintosh and Linux platforms in 
addition to Windows. Notable changes are detailed below. Fledermaus 
professional users, using version 6.5 or 6.4.1 should upgrade to this release as 
soon as possible to get the PFM fixes included with this release. VesselManager 
has also been overhauled in this release adding support for multiple vehicles 
when using standard NMEA messages, and support for receiving data directly 
from a network. 
 
Fledermaus Standard Version: 
 
Fledermaus: 
 

- Added Space Navigator device support for the Macintosh and Linux 
platforms as well as Windows. 

- Added enhanced control to the route so that the start and end node can 
be manipulated.  

- Improved Autocad DXF/DWG import. 
- Improved Shapefile import (z support in multipoint shapes, better support 

for reading height from the associated DBF files). 
- Minor improvements to the surface difference algorithm. 

 
Imageviewer: 
 

- Added ability to read floating point GeoTIFF files 
 
Avggrid: 
 

- Fixed a potential (up to 1) cell shift in how a point contributes to the 
surface being built.  

 
Dmagic: 
 

- Added ability to read images and DEM files in BIL (Binary Interleaved) 
format. 

- Added ability to read float point GeoTIFF files as surfaces 
 
 
 
Fledermaus Professional Version:  
(Includes everything from standard) 
 



PFMDirect: 
 

- Added a new tide format used to apply tidal correction of FAU files. 
- Added an option to build PFM data sets using the “Survey 21” projection. 
- Added support to read SURF4 formatted files 
- Added support to read Reson PDS2000 files (Requires a new version of 

PDS2000) 
- A memory leak building PFMs with GSF files that contain pings with a 

variable number of beams was fixed.  
- A problem was fixed building pfms that could in certain circumstances lead 

to some corruption of the PFM and problems unloading soundings. 
 
Fledermaus: 
 

- When importing S-57 files, a new option to project the data on the fly to 
UTM is now available. 

- Writing of Bathymetric Attributed Grid (BAG’s) is supported from CUBE 
based PFM data sets (when projected into UTM). 

- Added the CARIES export format when exporting soundings from PFM 
data sets. 

- Fixed a bug when filtering soundings from the cube surface for 
Geographic, PFM files when using the “Filter off the slope” option. 

 
VesselManager: 
 

- The user interface, in particular the setup section, has been completely 
overhauled in this release for better ease of use and support of new 
features. 

- Data can now be received as network UDP data as well as through the 
serial port. 

- Multiple vehicles are now supported when using NMEA messages. 
Previously this was limited to use with the custom format. 

 
 

 



Version 6.5 21 June 2007 
 
This release adds a number of powerful new features, such as S-57 importing, 
automatic Google Earth export tiling, and support for the Space Navigator 
interaction device on Windows. This release also includes the introduction of 
some major enhancements to PFMDirect that can greatly speed up the build 
time, as well as a number of bug fixes.  
 
Both Fledermaus Standard and Professional: 
 

- Fixed Linux 32 bit dongle issues.  
- Added support for dongles on Windows 64 bit machines. 
- Added support for Linux 64 bit.  
- Added support for new “driverless” dongles (BLUE) 
- Added support on Windows 32-bit platforms for the Space Navigator 

interaction device. 
 
NOTE: The drivers that are currently packaged with the Space Navigator will not 
work with Fledermaus. The latest drivers from the 3Dconnexion 
(http://www.3dconnexion.com/) need to be downloaded an installed.  
 

- New ability to import S-57 chart data as vector and point objects in 
Fledermaus.  

- New option to reverse the profile window color to allow easier printing.  
- Improved ESRI Shapefile reading that now supports more entity types.   
- Added ability to save a screen capture dialog in JPEG format.  
- 3D Objects and Images are automatically geo-referenced on load if 

possible. 
 
Fledermaus Standard Version: 
 
Routeplanner: 
 

- Added end nodes to the node list. 
- Added enhanced control to the route so that the start and end node can 

be manipulated.  
 
Imageviewer: 
 

- Improved KML (Google Earth) export to support: 
o Compressed files (KMZ) 
o Automatic tiling of large data files 
o Creation of web ready files for hosting on the Internet 

 
Avggrid: 
 



- Added ability for the ASCII reader to automatically skip up to a 100 lines of 
header data per file.  

 
Dmagic: 
 

- Added a new “clamp” option to the histogram rescaling of a DTM. This 
option will set areas outside of the min and max to the lowest and largest 
values respectively. The default option remains “clip” which sets all values 
outside the selected area to 0.  

 
 
Fledermaus Professional Version:  
(Includes everything from standard) 
 
PFMDirect: 
 

- Greatly improved build speed using a new caching algorithm. 
- Improved memory usage when loading large numbers of files. 
- Fixed a potential crash when using CUBE with very large data sets.  

 



Version 6.4 5 February 2007 
 
This release is focused on expanding the supported platforms to include the 
latest operating systems and hardware. This includes native support on Intel 
based Macs, as well as a special new version of Fledermaus designed to run on 
64-bit versions of Windows, including XP 64 and Vista 64-bit. The 32-bit 
Windows version of Fledermaus has also been updated to support Vista 32 bit. In 
addition to these new versions, a number of useful improvements and bug fixes 
have been added.  
 
Both Fledermaus Standard and Professional: 
 

- New Universal Binary distribution to allow native support on both 
PowerPC and Intel based Macs. 

- New 64-bit Windows distribution that supports Windows XP 64 as well as 
Windows Vista 64 bit. 

- Support for Windows Vista 32 bit.  
 
Fledermaus Standard Version: 
 
Fledermaus: 
 

- Greatly improved the speed of loading textured mapped objects.  
 
Routeplanner: 
 

- Improved rendering of the profile line for better visibility 
- Improved rendering when moving a route 
- Usability improvements for selecting a route for profiling, particularly the 

endpoints of the route.  
- Routes can now be exported as a navigation file readable by 

VesselManager. 
- Routes can also now be brought into Fledermaus as a true 3D pipe object 

using the “linetomodel” command line applet.  
 
Imageviewer: 
 

- New ability to export an image or SD file to a KML file (Google Earth).  
 
Movieclient: 
 

- New ability to set a specific range of frames for rendering  
- Fixed a smoothing bug affecting the last frame in a flight path 

 
Avggrid: 
 



- You can now specific the gridding type on the command line  
- You can specify in input pattern filter for files (such as *.data) 

 
Dmagic: 
 

- Added support for reading GMT Version 4 Surfaces 
 
Fledermaus Professional Version:  
(Includes everything from standard) 

 
Fledermaus: 
 

- New ability to export records from a PFM directly from the source files. 
- New option for CUBE filtering using IHO depth guidelines.  
-  

 
PFMDirect: 
 

- New method for creating TPE based on IHO accuracy guidelines. 
- Improvements for calculating multibeam errors when the input files do not 

contain all navigation parameters.  
- New options for ‘unloading by saving’ for formats that support the 

functionality.  
- Can now use up to 10 extra attributes in a PFM. 
- Improved accuracy for attributes stored in a PFM.  
 

 
Version 6.3 2 August 2006 
 
This release combines a number of new features and data parsers along with 
general improvements and fixes throughout the software suite.  The complete 
switch to a new image handling library will provide both increased speed and 
better memory usage, especially for Windows users. These enhancements are 
available both when reading and writing very large image files.  
 
Fledermaus Standard Version: 
 
General: 
 

- All image functionality converted to use the new image handling library 
- Created a license server installation package 
- Created a licensing wizard for license setup and troubleshooting 
- Added support for LAS format (versions 1.0 and 1.1) 
- Added support for SMA BDI format 
- Added support for XSE format 



- Cleaned up parser for HTF data format 
 
Movieclient: 
 

- Added ability to do background rendering  
 (On graphics cards that support auxiliary buffers) 
- Added a batch mode 
- Added background color choice 

 
Imageviewer: 
 

- Standardized GUI to match other 2D applications 
- Added status display to top of window 
- Added mode icons at top right 
- Added projection capability to convert between geographic and UTM 

 
Avggrid: 
 

- Added ability to project data files during gridding  
- Added support for polar stereographic data  
- Export to an ASCII file now includes all fields from the input data 
 

Fledermaus: 
 

- Fixed color map legend display so depth based color maps never change 
- Added option to display integer interval color map legends 
- Greatly improved DXF reading, supporting all versions of DXF 
- Added ability to import DWG files 
- “Create Mapsheet” moved to tools menu 

o Added optional north arrow 
o Added distance scale  
o Add option to create geographic Mapsheets 

 
Dmagic: 
 

- Added ability to save an image of the color map legend 
- Added support for reading CARIS BASE surfaces 
- Added support for reading BAG format surfaces 
- Added ability to interpolate grids 

 
Crosscheck: 
 

- Added ability to export X,Y,Z, difference to an ASCII file 
 
Command Line Tools / FMCommand: 

 



- Added a mkscene applet (for making .scene files) 
- Added a surface difference applet 

 
 
Routeplanner: 
 

- Added ability to export a flight-path along a route 
- Standardized GUI to match other 2D applications 
- Added color map legend display 
- Improved how routes are drawn 
- Control points now in color 
- Cross-profile functionality 
- Option to calculate route distance over ground 
- Added warning about loading geo data sets 

 
 
Fledermaus Professional Version:  
(Includes everything from standard) 
 
PFMDirect: 
 

- Ability to delete one or more lines from a PFM data set 
- Created an advanced error model section for CUBE builds  
- Added ability to set a fixed CUBE capture distance 

 
Fledermaus/PFM:  
 

- Changed PFM surface names from ‘filtered’ to ‘edited’ 
- Added ability to run CUBE filter using a fixed distance 
- Added ability to set selected hypothesis using the feature sounding flag 
- Added ability to use depth based color maps with PFM data sets 



 
Version 6.2.1 26 February 2006 
 
This version is a maintenance release designed to roll in any patches from 6.2.0, 
as well as any bug, packaging, and documentation fixes not yet released.  
 
Fledermaus Standard Version: 
 
General: 

- Fixed jpeg saving issues on unix and Macintosh platforms 
 
DMagic:  

- Reduced memory usage for the slope surface calculations. 
- Added the ability to unload surfaces to save memory in dmagic along with 

other minor user interface tweaks. 
- Added the ability to reverse North/South ordering when reading raw binary 

data. Also added the ability to specify the geographic bounds in the import 
dialog. 

- Fixed a bug when exporting a surface as 8bit raw binary data. 
- The statistics dialog now works for scalars as well as DTM’s. 
- Fixed a bug in the ERMapper surface importer so the ‘DataFile’ parameter 

is properly handled. Also fixed an issue which could lead to improper geo-
bounds when reading ERMapper files. 

 
Fledermaus: 

- Fixed a bug where filled polygon ESRI shape files were not being filled. 
- Greatly improved our handling of filled polygon files. Badly formed ESRI 

shape files (ones with intersecting edges) no longer cause Fledermaus to 
crash. 

- Added the ability to specify a sampling interval when saving a profile from 
the profile dialog. 

 
Avggrid: 

- Minor GUI tweaks to make the display work better on low resolution 
screens.  

 
Imageviewer: 

- Fixed a problem saving TDR shade files and enhanced the output to allow 
writing either TDR shade or scalar files. 

- A number of fixes to solve potential application crash problems. 
 
Movieclient: 

- Some improvements to the movie smoothing of turntable based flight 
paths. 

 
 



Fledermaus Professional Version:  
(Includes everything from standard) 

 
PFMDirect: 

- Fixed possible corruption of a PFM when the user assigns the record and 
subrecord values to the extra attribute fields. 

 
Fledermaus/3D Editor: 

- The PFM soundings export dialog now supports exporting soundings from 
a polygon selection as well as the rectangular selection.  

 
Crosscheck: 

- Significantly improved crosschecks memory usage. 
- Numerous small GUI improvements and fixes for potential crash issues. 

 



Version 6.2 17 December 2005 
 
This release combines a number of new features and data parsers along with 
general improvements and fixes throughout the software suite. Rendering speed 
has been greatly improved – it is up to 20 times faster on the Windows platforms. 
The other platforms have improved speed as well although not as dramatically. 
This affects all rendering from DMagic, to Fledermaus, to the 3D Editor. Version 
6.2 introduces a new architecture for handling imagery and the Imageviewer 
application has been rewritten to use it. Large image support is greatly improved 
as is the speed when working with these images. In future versions more 
functions of DMagic and Fledermaus will also use this new imagery handling 
architecture. DMagic contains some of the most visible changes as the project 
menu has been combined in the File menu and some of the menu options have 
been renamed to improve clarity. The vessel tracking module of the software has 
been completely rewritten and includes greatly enhanced functionality. The PFM 
structure has been improved. Now all the components of a PFM are contained 
within a directory structure. At the top level you will only see the filename.pfm file 
and an associated filename.pfm.data/ directory that contains everything related 
to the given PFM file. 
 
Fledermaus Standard Version: 
 
General: 

- Greatly improved rendering speed for all objects in Fledermaus and 
DMagic. 

- Improved installation manual.  
 
DMagic:  

- The project menu has been removed and its functions are now 
incorporated into the File menu. The import gridded and ungridded data 
menu names have been renamed for clarity. 

- A new masking tool dialog is available from the tools menu. It allows you 
to mask (knock holes in) a DTM based on a separate DTM or image file. 

- If a geo file is loaded with a DTM, the shading dialog will now show real 
sun azimuth and elevation angle measurements in degrees. 

- The color map range displayed is now tied to the encoded scalar range of 
DTM’s and Scalars rather then tied to the .geo file. This solves many 
inconsistency problems especially when working with Scalar and DTM 
files together. 

- The imagery import dialog have be improved for clarity and ease of use. 
 
Fledermaus: 

- The ESRI shapefile parser was completely re-written from scratch. All 
shapefiles except the mesh shape should now be supported. 

- Images can be saved in jpeg format. 
- Completely redesigned real-time vehicle tracking functionality. 



o Much better support for accurate measurements of distances for 
§ Vehicle to Vehicle 
§ Vehicle to nearest point on a line object 
§ Distance to surface below vehicle 
§ Distance to any SD object in the scene or to a fixed location 

o Distance alarms when the point of approach crosses a threshold 
o Much improved multiple view handling 
o Track the vehicle route history 
o Profiling below the vehicle and special options to track points of 

approach in narrow channels. 
o Support for both geographic and projected coordinate systems 
o Much better control of vehicle dimensions and identification of the 

instrumentation positions on the vehicle itself. 
 
Avggrid: 

- When gridding a cropped region, the background color of the grid bounds 
part of the GUI changes to more vividly indicate that a cropped gridding 
operation is taking place. 

- Bug fixes and minor improvements. 
 
Imageviewer: 

- Imageviewer is now built on a completely new image handling layer which 
handles huge images in a much improved fashion. Many of the I/O 
interfaces to image formats have been updated to take advantage of this 
new engine. Tiff image handling in particular has been greatly improved. 

- Saving of jpeg images on all platforms is now supported. 
- Unsupported image formats or format variants are handled more 

gracefully now and properly informs users when a problem is found. 
 
Movieclient: 

- Improved smoothing especially with flight paths made in the turntable 
mode. 

- General bug fixes and code optimization. 
 
FMCommand/Cmdop: 

- Major cleanup of the applets provided by cmdop. Removed obsolete 
applets and enhanced the help of most applets. 

- Numerous ease of use improvements to running commands.  
o Properly remembers recently used directories 
o Double clicking file names inserts them into the command at the 

cursor rather then always appending them. 
o A command history makes it easy to repeat commands or see a 

trail of activity. 
o All applets provide feedback of when they complete. 

 
 



Fledermaus Professional Version:  
(Includes everything from standard) 
 
New Point Parsing Format Support For: 

- SHOM Pivot format 
- LADS Lidar format 
- Danish FGE (A geographic format variant of the FAU format) 
 

PFMDirect: 
- Unload support for the Hypack HS2 data format. 
- Minor interface improvements. 

 
Fledermaus/3D Editor: 

- Greatly enhanced target/contact support based on storing contacts in the 
NAVO XML format. Targets can be viewed, edited, deleted, or added in 
the main 3D surface view or within the 3D editor. Image snippets can be 
viewed and associated with specific targets. 

- Number user interface improvements for better clarity and usability. New 
sounding, CUBE, and target editing modes. 

- Optimized tracking of edits in the 3D editor. 
 
Crosscheck: 

- Added support for the IHO Special Order statistics. 
- General bug fixes and interface improvements. 
- Improved the slider for controlling the visualization of point differences. 

 
VesselManager: 

- The old ROVManager program has been renamed VesselManager. 
- Much improved configuration options and NMEA support. 
- Supports auto projection to UTM and polar stereographic projections. 



Version 6.1.5              14 July 2005 
 
This release is primarily a maintenance release to roll in all the patches from 
6.1.4, as well numerous other bug fixes that were not released as patched. In 
addition, significant improvements have been made to both the installation 
manual and the licensing procedures. These improvements have been made to 
make the software easier to install and troubleshoot errors.  
 
Fledermaus Standard Version: 
 
General: 
 

- Fixed reading data from an Isotrak II device on Mac OS/X. 
- Improved installation manual.  

 
DMagic:  

 
- Improved reading of DEM files to support more variations. Added toggle in 

importer for ESRI variants. 
 
Fledermaus: 
 

- Fixed bug with cutting sections of a line file on import. 
- Improved geo-referencing of 3d points. 
- Fixed occasional bug with the display of scene names in the title bar. 
- Added ability to clear a scene from Fledermaus. 

 
Avggrid: 
 

- Adjusted interface to better display cell size precision. 
- Fixed potential clipping of the maximum values in a DTM. 
- Fixed duplicate overwrite message when export data. 

 
Imageviewer: 
 

- Colour picker is fixed for grayscale images. 
 
Movieclient: 
 

- Fixed improper display of mpeg settings when in image only mode. 
- Fixed crash on Windows platform. 

 
FMCommand/Cmdop: 
 

- Cleaned up dtmmask help text. 
- Documented how to use labels with mkpoint3d. 



- Added new multiplatform dialog for display of dongle and host ids. 
 
 
Fledermaus Professional Version:  
(Includes everything from standard) 
 
PFMDirect: 
 

- After creating a configuration file, it is selected in the list of files.  
- Added auto-detection of hemisphere lat/lon files. 
- Clarified the labels and example for setting the Z-range. 
- Fixed typo in "Swedish National Grid". 
- Fixed a bug in unloading single beam data stored in the SURF format. 
- Added better detection of SURF single beam files. 
- Improved the field mapping for custom filters in PFM configuration files. 
- Added code to reset the append wizard each time it starts. 
- Added mappings for extra HS2 attributes used in error attribution. 
- Fixed an unload problem with Neptune files that were compressed and a 

different endienness. 
- Fixed problems with using custom filters and CUBE at the same time. 
- Added code to clear the checked flag after appending new data. 
- Added ability for more formats (other than ASCII) to unload by saving. 
- Improved reading and writing of B93 files. 
- Fixed appending for data that is in the Swedish National Grid projection. 
- Clean up of the custom filter set up interface. 
- Fixed minor bugs with the display of the progress bar during build and 

append operations. 
- Added additional information to the append results dialog to help diagnose 

problems. 
- Added code for setting up and running custom filters during an append 

operation. 
- Fixed problem with some FAU files not being read properly (endienness 

detection issue). 
- Fixed unload problem with FAU data that does not have any beam angle 

information. 
- Added ability to provide a manual data range for each extra attribute. 
- Added code to auto match attribute names with source file field names. 
- Fixed area based filter when run from the PFM build wizard. 

 
Fledermaus: 
 

- Added the ability to read an XML target file (up to 256 targets) and use 
during the CUBE filtering process. 

- Ability to export XYZ plus attributes to an ASCII file from a PFM. 
- Changed the default for setting checked areas to “selection” for safety 

reasons. 



- Fixed a bug preventing a bin from being marked as suspect if it was 
already marked as checked. 

- Fixed a bug with marking data from a custom filter as modified. 
 
Crosscheck: 

 
- changed reference surface creation dialog to force the saving of the surface. 

 



Version 6.1.4   28 March 2005 
 

 
Version 6.1.4 is primarily a minor enhancement/bug fix release. Notable 

changes in this version include: 
 

Fledermaus Standard Version: 
 
General: 

- Support for dongles on Mac and Linux. 
 

FMCommand/cmdop: 
- Added dtmmerge program to merge multiple DTM files together. 

 
Bugs: 

- Fixed a bug in rendering the last frame of movies. 
- Other minor bug fixes. 

 
 
Fledermaus Professional Version: (Includes everything from standard) 
 

PFMDirect: 
- Added support for custom filters as one of the stages of the build 

wizard. 
- Ability to store configuration files for PFMDirect to simplify repetitive 

builds. 
- PFMDirect can apply tides to FAU format files. 
- Updated flags for TOF/HOF format. 
- Updated support for ARE files to allow conversion between 

geographic and UTM coordinate systems. 
- CUBE algorithm can now be run on Neptune files. 

 
3D Editor: 

- Added a slice-based editing mode to limit the soundings displayed 
in the 3D Editor to strips of data. 

 
PFM: 

- When applying CUBE filter soundings algorithm, added support for 
ignoring soundings around a set of targets. 

 
Bugs:  

- Fixed problems with OMG, HS2, and Neptune formats. 
- Other minor bug fixes. 



 
Version 6.1.3   20 December 2004 

 
 

Version 6.1.3 is primarily a minor enhancement/bug fix release. Notable 
changes in this version include: 

 
Fledermaus Standard Version: 

 
General: 

- For each program, added the date and time the program was 
compiled to the About dialog box. 

 
fledermaus: 

- Added an option in the General Preferences dialog to reset the 
docking windows interface.  

- Can now display metric values in the ‘Create Map Sheet...’ dialog. 
- Fixed some problems with extended character sets.  
- Added an indication of the units for label sizes when generating 

contours. 
- Can now change the color map for line files in Fledermaus by 

clicking the ‘Change Color’ button. 
 
dmagic: 

- The ‘Project > Import from .sd or .scene’ now works on a variety of 
objects and will properly extract geotiffs from files. 

- When shading files, areas in the shade file that contain no data are 
now always black (previously they could be black and/or a dark 
purple). 

- The importer for the ‘Surfer Grid’ format can now automatically 
detect ASCII or binary Surfer files.  

 
avggrid: 

- Files become disabled in the file list if they cannot be read. 
 

Bug fixes: 
- Fixed a problem importing certain ArcInfo Shape files.  
- Fixed a problem using the 3D grid class. 

 
Fledermaus Professional Version: (Includes everything from standard) 
 

PFM: 
- In the Tools menu, added an ‘Export Shoal Sounding’ option, which 

writes the shoal sounding in each bin of the selected area to a file. 
- Fixed corruption issues on the PC when working with PFM files 

over 2 Gigabytes. 



- Add units to indicate what the constant error fields should be when 
using CUBE. 

- Fixed a problem unloading a CUBE PFM when there were no 
soundings in a bin and the hypothesis was modified. 

- Fixed a problem in the CUBE export sounding procedure when the 
chosen hypothesis only contains a single sounding. 

- PFM datasets do not lose custom color map ranges so easily. 
- Added a CUBE Options dialog to control the current hypothesis 

resolution algorithm and the capture distance. 
 

Data formats: 
- Addition of the B93 format (NIMA) Reader. 
- Addition of the HS2 (Hypack) Reader (read only). 
- Added SURF support for reading and calculating TPE values.  

 
3D Editor: 

- When editing CUBE nodes, now support setting a custom 
hypothesis in bins where no hypotheses were generated. 

- After editing a section of data with the 3D Editor and committing 
edits, only the modified section of the surface is reloaded in the 
main display. This greatly speeds up editing on large surfaces. 

- Polygon selection now works properly when editing CUBE 
hypotheses. 

 
fmcommand/cmdop: 

- Import/Conversion of Mercator Charts 
- Optimizations to the pfmaddline program.  
- Added options to xyztofph to move the camera vertically up or 

down, or to tilt the camera up or down. 
 

Bug fixes: 
- Fixed problems writing HTF/HTB files.  

 
 
 
 



Version 6.1.2   17 September 2004 
 

 
This release contains a few significant functional enhancements and 

includes all of the patches released from 6.1.1. This maintenance release of 
notable fixes and improvements includes: 

 
Fledermaus Standard Version: 

 
General: 

- Fixed a problem building Geographic PFM with longitude coordinates 
in the [-180, 360] degree range. (as opposed to only [-180, 180]). 

- Fixed serial port I/O problems on the MacOS 10.x platform. 
ROVManager now works on that platform as does all the 3D input 
devices used for flight mode in Fledermaus. 

 
iView3D: 

- The top number keys on the keyboard can be used as shortcut keys 
to toggle on/off the 1st ten data sets loaded. 

- A new preferences dialog allows iView3D to startup in stereo mode. 
 
dmagic: 

- In the File >  Export Surface dialog an option was added to write out 
a GMT/NetCDF digital terrain file. 

- The File > Import Imagery dialogs have improved support for using a 
TDR shade file as the image to work with. (It will automatically read 
georeferencing data from a .geo file of the same base name.) 

- Fixed a significant memory leak when shading surfaces, which could 
cause dmagic to run out of memory with larger data sets. 

- Fixed an incorrect default output name in the File > Import Imagery 
dialogs when an image contained a filename with extra dots in it. For 
example “westCoast.250m.tif”. 

 
avggrid: 

- Fixed a bug in the shoal biased surface generation that caused the 
rejection flag on soundings to be ignored. 

 
fledermaus: 

- Surface contouring now supports creating labeled contour lines. 
- For Line3D objects, the line width attribute was not properly saved 

when written to a scene file. 
- The profiling dialog has a new feature. Normally if you click and drag 

it displays statistics about the dragged area, however if you just click 
on the profile then Fledermaus will place the 3D selection point at the 
point along the profile that matches in the main display. This makes it 



much easier to correlate a profile location with its 3D location in the 
scene. 

- Fixed a potential crash problem when using the resample and drape 
option for a 3D line object. 

 
fmcommand/cmdop: 

- The cvttm, cvtutm, tmtogeoimage, and utmtogeoimage applets now 
properly support projection of longitudes in the full [-180, 360] degree 
range instead of just [-180, 180]. 

- Greatly reduced the memory requirements of dtmmerge. 
- Fixed a problem that caused the Fledermaus license to disappear if 

you tried to install it when it was already in the correct location. 
 

Fledermaus Professional Version: (Includes everything from standard) 
 
General: 

- Fixed a significant PFM problem that could case some corruption as 
the PFM file got extremely large. 

 
pfmdirect: 

- Modified the VISE format unloader to handle files that don’t have a 
consistent number of beams per ping. 

- Improved the reading of area files when specifying PFM bounds. 
- Fixed a bug in the GSF reader that prevented the along track 

corrector from being applied properly. 
 

fledermaus: 
- The export soundings dialog from a PFM is much more sophisticated. 

It allows more control over what data is exported and can unproject 
CUBE/PFM soundings if necessary. Data can be exported as simple 
ascii or in the NAVO/Caris GIS import format. 

- CUBE/PFM filtering now pays attention to the surface slope when 
used as a rejection filter. 

- New 3D editor point measurement tool. You can now interactively 
measure distance and bearings from one point to another. 

- Fixed a bug that cause PFM target snippets not to display. 
 

ROVManager: 
- Improved the update rate. Previously it was too slow and could fall 

behind on certain circumstances. 
- Added support for the generic NMEA strings for reading data from a 

single vehicle. ($GPGGA & $GPHDT are now supported.) 



Version 6.1.1   09 July 2004 
 

 
This release is primarily a bug fix and minor update release. It also 

integrates all of the patches released as 6.1.0b into the full distributions. For 
platforms specific fixes, the special rendering hack for Macintosh platforms has 
been removed as Apple has now fixed the bug that we had to work around. If you 
are using Panther you must upgrade to at least version 10.3.4 of the Mac OS. 
The Linux distribution was also improved to remove possible conflicts with KDE 
related libraries. Notable fixes and improvements include: 

 
General: 
   - Added support for ESRI style tiff world files. 
   - Fixed a bug reading EXIF jpeg files. 
   - Updated the tiff and geotiff libraries. 
   - Fixed a problem reading Transverse Mercator geotifs. 
           
iView3D: 
   - Fixed a bug that caused movie playback to not function. 
   - Updated iView to match the latest Fledermaus scene file format. 
    
avggrid: 
   - Fixed a memory leak when gridding a PFM index file. 
    
dmagic: 
   - Fixed a bad error check when importing a HIPS grid file. 
   - Fixed a problem in the Project->New Project dialog when  
     entering the slash (path separator) character. 
      
fledermaus: 
   - Fixed a crash in the dynamic PFM update when using polygon  
     select to load soundings. 
   - Fixed a show/hide file/line problem which occurred if the files 
     were not added to the PFM in alphabetical order. 
   - Now no 3D device is selected by default. The 1st time the 
     preferences will open and request that you select the  
     appropriate 3D device that you are using. 
   - When starting a 3D device the software now attempts to figure 
     out if you selected the wrong device and inform you of that. 
   - Added a -flightpath command line option which brings up the 
     movieplayback dialog upon startup. 
   - Fixed a bug that prevented the active point SD object type 
     from properly triggering the attached action. 
   - Fixed a memory leak when using the create mapsheet option. 
    
PFMDirect: 



   - Fixed problem with unloading CARIS HDCS data. 
   - Fixed some memory leaks reads HDCS data. 
   - Added extra error checks for disabled beams in HDCS data. 
   - Fixed a memory leak in the basic I/O parser when reading subrecords. 
   - Fixed an issue setting the southern hemisphere when cubeing a PFM. 
   - Fixed a HDCS project browser bug when selecting just one line of data 
   - Fixed a problem that prevented standard deviation from being 
     calculated when building a CUBE based PFM. 
      
movieclient: 
   - Added a -pushback command line argument. Necessary to properly 
     render movies if the user changed the pushback slider within 
     Fledermaus before creating a movie flight path. 
         
cdmop: 
   - Updates to pfminitialize and pfmaddline.  
   - Added a new program: hyd93toxyz which converts Hyd93 (.b93) 
     sounding files to ascii xyz. 
   - Fixed an error check in scalarmask and setbound applets. 
   - dtmmerge was not showing up in the list of available applets. 
   - Added cvttm companion to cvtutm for improved handling of 
     Transverse Mercator files (with different central scale factors). 
     
imageviewer: 
   - Added a warning if an image file failed to save 
   - Added a feature to resample images by cell size 
   - Fixed a bug that prevented entering zero as a valid 
     geo-coordinate in the x-bounds. 
 
omniviewer: 
    - Fixed the display of many HTF attributes 
     
General PFM: 
   - Fixed a situation when reading TPE measurements for soundings 
     could get out of sync with the beam structure. 
   - We now read TPE data from SURF files (assumes it is variance) 
   - Numerous improvements to the loading and unloading of 
     Neptune data including much improved flag handling. 
   - Fixed a sub-record inconsistency between the parser and the 
     PFM attributes. 
   - Fixed a subtle PFM readbin problem. (caused an occasional  
     flag set/read problem) 
   - Optech GCS Fixes 
       - Dynamic update fix in 3D editor for polygon selected region 
       - Setting suspect flags from HOF files 
       - Setting the 1st return for TOF files as a secondary depth 



   - Greatly improved the speed of dynamic unloading when the 
     PFM contains many source files. 
   - Better handing of extra files in the HDCS day directory and zero 
     sounding processedDepth files. 
 
 



Version 6.1   22 Apr. 2004 
 

 
Standard vs Professional Editions of Fledermaus: 
 

Starting with version 6.1 of Fledermaus, the software suite is now 
available in two configurations: Standard and Professional.  

 
• Standard - The Standard configuration contains the main visualization 

functionality including the programs Fledermaus, DMagic, AvgGrid, 
ImageViewer, Movieclient, FMCommand, and cmdop (minus any 
functionality for working with PFMs or ROVs). 
 

• Professional - The Professional configuration contains all of the features in 
the Standard configuration plus tools for Area Based Editing (PFMs), 
routeplanning, and ROVs. The following applications are also included in 
the Professional version: PFMDirect, Routeplanner, OmniViewer, 
CrossCheck, ROVManager, Wave-400, and Wave-1000. Any customers 
who own Fledermaus and did not explicitly purchase the Standard Edition 
are entitled to receive the professional version of the software. 

 
Auto-Processing (Cube): 
 

One of the main enhancements with version 6.1 of Fledermaus revolves 
around a new method of auto processing data of point editing within the PFM 
data structure called CUBE (Combined Uncertainty and Batymetry Estimator.) 
For more information on CUBE processing, see Chapter 6 of the Area Based 
Editing Manual. Integral to the CUBE process is the assignment of error 
estimation for point data being feed in the area based editing/CUBE process. 
PFMdirect supports numerous enhancements to provide robust total propagated 
error modeling, along with other more simplistic methods for error attribution. 

 
The main idea behind CUBE is to statistically generate a set of possible 

heights for a surface (also called hypotheses), taking into account the uncertainty 
of soundings. CUBE hypotheses are attached to a PFM file and can be 
generated via PFMDirect by enabling the Auto-Processing (CUBE) toggle at the 
top of the interface. Once CUBE hypotheses have been generated and errors 
specified using PFMDirect, the hypotheses can be viewed in Fledermaus by 
opening the PFM. The hypotheses can also be edited in the 3D Editor by 
enabling the Cube toggle in the 3D Editor interface. After processing is complete, 
the Tools menu in the PFM Attribute area in Fledermaus contains options for 
writing out the CUBE surface or running filters based on the surface. 
 
 
Application-Specific Changes: 
 



Besides the new functionality for working with CUBE datasets and the 
changes with Standard and Professional configurations, many applications 
contain enhancements some of which are listed here: 

 
• Fledermaus: 

o Support was added for the new Patriot 3D Flight device (the 
successor of the IsoTrak II). Better support was incorporated for 
reading serial ports on the Mac. In the object Attribute panels, a 
new dialog was added to Transform (rotate, translate, or scale) the 
vertices of a solid model. Also, a button was added to easily rotate 
a vertical image. 

o Numerous minor interface tweaks and enhancements. 
o Improvements to the surface series class. 
o A new 3D point object type than can trigger actions like launching a 

web browser or running a movie when clicked is now supported. 
• Dmagic: 

o Added an importer for Arcview ASCII Grid files. 
o Interface enhancements to the surface slope calculator. 
o Many smaller interface improvements for ease of use or clarity. 
o Fixed problems that sometimes caused dialog boxes not to 

disappear properly. 
• Avggrid 

o Added an ‘Export to Scalar/Geo File’ command on the File menu. 
o User interface improvements to the export points option. 

• PFMDirect: 
o Fixed a bug with appending files. The Verify PFM utility now 

properly modifies data file paths. Better support was included for 
working with HTF/HTB files.  

o Major updates to support CUBE based processing. 
o Improvements to the Neptune Multibeam format parser to properly 

read tide corrected files. 
• 3D Editor 

o Improved support for the dynamic unload of HOF/TOF files. Bug 
fixes with some of the coloring modes. Major updates to support 
new CUBE functionality. 

• Movieclient  
o Better support for antialiasing of movies. 
 

• Crosscheck  
o Support to show the measurement points on the reference surface 

and color code them by the difference amount. 



Version 6.0.1   9 Feb. 2004 
 

General Changes: 
 

This is primarily a bug fix release that integrates the current set of 
released patches. The following programs have had updates. 

 
PFMDirect: 
   - Fixed crash when trying to load / unload CARIS HDCS data. 
   - Fixed reverse ordering of files in the PFM structure. 
   - Fixed the survey line numbering issue. 
   - Activated optimized unloading for all formats. 
   - Fixed problem with unloading to new files ( ASCII format only ) 
   - Improved error checking for when unloads fail 
   - Fixed broken progress bar for appending and unloading 
 
Dmagic and Avggrid: 
   - Fixed crash when gridding CARIS HDCS data. 
 
Imageviewer changes: 
   - fixes: much faster file loading, selection box, and alpha mask. 
   - new features: colour picker, alpha mask(transparency) by colour 
 
  Imageviewer can now load large images quickly for efficient processing. 
  A new colour picker and alpha mask by colour feature allow you to make 
  specific colours in your image transparent for draping. 
 
Movie Client: 
   - Fixed render magnification and anti aliasing issues. 
 
Fledermaus: 
   - Fixed specifying a pfm file on the command line. 
 
 



Version 6.0.0   11 Dec. 2003 
 

General Changes: 
 

This is a major new release of the software system and features a 
completely re-written user interface that is native on all platforms (Exceed is no 
longer required on Windows platforms for example.) Although the interface has 
been greatly modernized the overall usage methods remain the same and users 
of older versions will soon feel at home. In addition to the Windows, Linux, Sun, 
and SGI platforms, as of release 6, the Macintosh OS X platform is now 
supported. All platforms share an identical set of features although integration 
options with other vendor’s tools may vary according to their platform availability. 

 
For the graphical applications, the CmapEditor and CmapCreate programs 

have been removed from the distribution. Their functionality is now included as 
part of the DMagic application. The MapMaker and DXFViewer programs have 
also been depreciated with their functions now part of Fledermaus. New 
graphical applications making their appearance as part of version 6 include 
FMCommand, CrossCheck, and OmniViewer as described below.  

 
Previous versions of Fledermaus included a wide variety of data 

processing command line applications (over 100 programs) in addition to the 
graphical applications. All the functionality of these applications is preserved in 
version 6 however the programs have been integrated into a single command 
line processing program called cmdop. The functions of this program can be 
directly scripted on the command line or accessed in a more user-friendly GUI 
format through the new FMCommand program. 
 
 The processing of XYZ type data and Multibeam Sonar formats has been 
greatly enhanced through a new I/O architecture. The new infrastructure provides 
consistent functionality between applications that read point data such as 
PFMDirect and AvgGrid. The new OmniViewer program provides a spreadsheet 
like view of any data format supported by the new I/O architecture.  
 
New Applications/Significant Enhancements:  

• FMCommand 
o This graphical program provides four functions. It aids setup 

and installation of the software and verification of licensing 
issues. It supports running and managing the 3D input 
devices such as the Bat and Logitech 3D mouse. Most 
importantly, it provides a graphical gateway to access the 
wide functionality of the command line programs. These 
programs often supplement the overall system tools and 
support many data processing tasks. You can run the tools 
within the GUI of the FMCommand program. Finally a launch 



bar with icons is provided in order to run all the graphical 
programs within the visualization system. 

• CrossCheck 
o Provides a powerful interactive analysis program for doing 

point vs surface comparisons. It can perform main line vs 
crossline survey analysis for IHO order 1 and 2 statistics or 
generalized comparisons. 

• OmniViewer 
o Provides a graphical spreadsheet like view of data contained 

in any format supported by the new point and multibeam I/O 
architecture. 

• Fledermaus 
o A new native interface for all supported computing platforms 

provides substantial usability improvements and streamlined 
data flow, but still maintains familiarity to existing users of 
the software. 

o New mapmaker output has been considerably improved and 
supports both geographic and UTM projected data sets. 

o New support for GeoWall and similar dual projector stereo 
display systems by supporting split screen visualization.  

o New profiling dialog consistent with that of DMagic and 
RoutePlanner. New options include interactive distance and 
slope measurements and the ability to save both the profile 
data and images of the profile display. 

o The GeoPicking panel now includes a table to store and 
manage picked locations. Point and line objects can be 
interactively constructed from the point table.  

• DMagic:  
o New native user interface with substantial usability 

improvements. While current users will still feel at home with 
the new interface many improvements have been made to 
improve data flow and integrate more functionality into the 
application. Key differences include integrating the shader 
into the main window display, integrating color map editing 
within DMagic, and improving the preparation of mapping 
imagery onto surfaces.  

o DMagic,  Fledermaus and RoutePlanner all share a common 
surface profiling tool that includes many enhancements. 

• AvgGrid 
o Major improvements to the user interface to improve 

usability and support new features. 
o Integrated support to process point data from any format 

supported by the new OmniReader parsing engine. 
o A detailed configuration panel allows precise control over 

what and how data is gridded. 
• Routeplanner 



o New native user interface with substantial usability 
improvements along with a profile tool consistent with that of 
DMagic and Fledermaus are the major changes here. 

• PFMDirect 
o Integrated support for the new OmniParser I/O engine. 
o Improved support for reading Caris HDCS formats. 
o Faster data unloading engine. 

• cmdop 
o New command line data processing application that 

integrates in a single application all the command line 
processing programs of the previous release (about 95 of 
them). 

 
 



 
Version 5.2.3   4 Sept. 2003 

 
General Changes: 
 

This version is primarily a bug fix releases although a few new features 
have been implemented. A new applet utmtogeoimage complements the 
geotoutmimage program providing a function to un-project an image file from 
UTM back to geographic space. 
 
New Applications/Significant Enhancements:  

• utmtogeoimage 
o Supports the projection of an image with UTM coordinates 

back into an image with geographic coordinates. 
• DMagic: New support for importing Caris weighted grid files into 

dmagic for further visualization and processing in Fledermaus. This 
functionality requires that Caris be installed on the system as well 
as Fledermaus. 

 
Minor Enhancements/Bugs Fixed:  

• Fledermaus – surface differencing on geographic data sets 
contained a bug that assumed the cells are square. This is true in 
projected data but not geographic coordinates. 

• Reading tiled tiff images often failed – now fixed. 
• Added write support for the BMP image format. Previously only 

reading bmp files was supported. 
• Support the idea of tiff world files for other image formats. If you 

have a filename with the same base name as an image with the 
last two characters in the extension changed to “fw”. Then the 
system will try to read that file for georeferencing data. This file has 
the same format as a tiff world file. For example test.bmp will look 
for a test.bfw file for georeferencing. For jpeg files, test.jpg will 
check for test.jfw.  

• DMagic: Added some missing hourglass cursors in dmagic and 
made sure assembled files get the .sd extension added by default if 
not entered by the user. In the extract region, custom bound 
extraction is now the default. Fixed a bug when switching projects 
after using the shading tool with scalars in the previous project. 

•  avggrid: You can now export scalar (.scalar) files as well as dtm 
(.dtm) files by specifying a filename that ends in .scalar. This makes 
it much easier to grid a data set for draping on a DTM at a later 
time in dmagic.  

• pfmdirect/avgrid: Fixed a problem gridding more than 320 GSF files 
in multiple directories. 

• Fledermaus: The 3D editor z-range now updates when lines 
visibility state is toggled on and off. 



• Improvements in the rovmanager and Fledermaus ROV display 
abilities when working over data sets with geographic coordinates 
as opposed to UTM coordinates. 

• pfmdirect – Fixed a bug building PFM data structures with UTM 
coordinates in the southern hemisphere. 

• Documentation – Updates to the installation manual to correct the 
bash shell setup on UNIX platforms. Also added better samples to 
show how to setup network licensing. 

• Updated the Caris HIPS reader to reduce the number of 
dependencies on environment variables. 



Version 5.2.2   30 May 2003 
 

General Changes: 
 

This version is primarily a bug fix releases although a few new features 
have been implemented. The pfmdirect program has substantial improvements to 
the unloading of pfm data back to the originating format. 
 
New Applications:  

• dtmmask 
o Knocks a hole is a given SD surface based on one or more 

other surfaces. Very handy when you have a large overview 
surface within smaller high resolution surfaces in the same 
region. 

• mksurfseries 
o Allows the construction of an animated surface from a series 

of SonarDTM SD files.  
• linetodxf 

o Converts an ascii xyz line file (such as that exported by the 
Fledermaus 3D line object) into an Autocad DXF R12 file. 

 
Minor Enhancements/Bugs Fixed:  

• The pfmdirect program used to create PFM data structures for 
Fledermaus has had a number of improvements when unloading 
data to make it much faster. C&C Binary formatted files are now 
properly detected as well. 

• mkvcurtain supports more flexible ascii files for geo-referencing 
including xyz as well as xy and is less fussy about the separator. 

• Scenes that include BasicDTM objects now have the object 
embedded in the scene file rather than saving a pointer to the 
original file. This is in line with how scenes are normally saved by 
default. 

• On the Sun platform the shared libcstd++ library is no longer 
required thus simplifying installation. 

• The gasciitoscalar command line program to import gridded ascii 
data now supports the same feature set as the dmagic importer. 

• In grdtoscalar the –invert option wasn’t functioning properly. 
• Imageviewer – If a regular tif image (not a geotif) was opened then 

the dialog box option to add geo-referencing was inaccessible. 
• Dmagic – you can now view a shade file without loading the 

corresponding DTM file. 
• The command line shade program now has a color map assigned 

by default if not specified and support for depth based color maps 
has been implemented. 

• Reading GSF multibeam files under windows failed if they didn’t 
have an associated index file unless the GSFTMPDIR environment 



variable was set. The reader will now obey the variable if set but 
still work if not. 

• Avggrid – When entering the format for multiple variable ascii files 
the pulldown menu to select which variable to grid didn’t always 
make all the variables immediately available. This has been fixed. 

 
 
Version 5.2   7 February 2002 

 
General Changes: 
 

This version combines many improvements in the area based editing 
(PFM related) tools provided by Fledermaus. In addition a useful new graphical 
program called imageviewer has been added. Along with basic image viewing 
this application provides useful tools for adding and managing geo-referencing 
data with images, reading and writing tiff world files, and many image editing 
features including resampling, format conversion, transformations, cropping, and 
alpha (transparency) channel support among other features. All the applications 
in the Fledermaus suite are now aware of tiff world files. Thus if a “.tfw” file exists 
that has the same base name as an image file the program will automatically 
read the data to extract useful geo-referencing data about the image. A new 
waveform viewer for Lidar data has been added although only the SHOALS lidar 
systems and data formats are currently supported.  

The area based editing module now supports loading data from a wide 
range of formats including: Ascii, GSF, Caris, C&C Binary, Shoals 400 and 1000, 
HTF (Hydrographic Transfer Format), Atlas, VICE, and Simrad Neptune among 
others. 

The ROV Manager application for passing realtime data streams to 
Fledermaus for ROV objects has been mostly rewritten. 
 
New Applications:  

• Imageviewer 
o Very handy application for image viewing, georeferencing, 

resampling, cropping, and other imagery transformations. 
• Gshhstolines 

o Extract shoreline vector data from the freely available xxx 
database for a given area and create an SD file to load into 
Fledermaus. 

• Geoutmtoimage 
o Reproject a geographic tif image into a UTM image. 

• Imageingester 
o Extract data from SD files and imbed the data into a source 

image file producing a new combined image file. 
• Crosscheck 

o A new application for doing cross line analysis with GSF 
sonar multibeam data. 



• Waveditor 
o An application for viewing SHOALS lidar waveform data. 

 
 

 
Changes to Fledermaus:  

• Major improvement to the File > Create Mapsheet option. You can 
now directly create printable quick charts for both projected and 
geographic data sets. The resulting charts are appropriately labeled 
and annotated. 

• A default view can be specified upon startup. 
• New integration features allow 3rd party systems to imbed 

Fledermaus within a larger system. 
• The ROV realtime object type in Fledermaus has been greatly 

enhanced providing support for loadable ROV models, navigation 
offset and size information and the ability to track distance and 
heading to multiple target locations. 

• Major PFM (Area based editing) enhancements. Support for user 
configurable PFM data structures, PFM attribute support. A variable 
highlight surface color by attribute was added among other things. 
The sounding selection algorithm has a number of interface 
improvements to facilitate more robust operation. 

 
Changes to the 3D Editor within Fledermaus:  

• Different cursors for different editing modes and full support for 
keyboard short cuts. 

• A user definable configuration file allows the launching and data 
communication between the 3D editor and 3rd party applications. 

• Substantially improved support for Lidar data including second 
depth display and management. 

• The ability to move the actively edited area in the compass 
directions without leaving the editor. 

 
Changes to Avggrid:  

• Support for new data formats. We currently read data from the 
following formats: Ascii, GSF, Caris, C&C Binary, C&C Trace, 
Shoals 400 and 1000, HTF (Hydrographic Transfer Format), Atlas, 
VICE, and Simrad Neptune among other. 

• Better support for reading extra attributes from most multibeam 
formats. 

  
 
Changes to DMagic:  

• You can create texture mapped (draped imagery) SD files directly 
from the GUI. (mktextureDTM is no longer required). 

• Better profiling support for geographic data sets. 



• New importers for DTED, and GUTM surface formats. 
 
 
Changes to PFMDirect:  

• This application has been completely rewritten. In addition to 
featuring a native interface on all platforms it provides robust 
functionality for building PFM data structures for area based editing. 
Data loading, gridding, PFM construction and unloading are all 
supported within pfmdirect now. 

• Projection of geographic to UTM can now be done on the fly when 
necessary. 

• Basic area filter support can now be enabled. 
 

 
 
Version 5.1.1   25 July 2002 

 
General Changes: 
 

This is primarily a bug fix release that addresses several issues found in 
the main 5.1 release. The only general change is to the directory selection 
file dialog. It now shows file names that appear in the directory along with 
the directories. 

 
Changes to Fledermaus:  

• Improved compatibility with older 3D line SD files. 
 
 
Changes to Avggrid:  

• Fixed a bad memory leak when parsing ASCII files. 
• Improvements parsing some of the supported multibeam formats. 

  
 
Changes to DMagic:  

• Fixed a problem in the NAVO Chartr Grid file. 
•  Robustness improvements to the importation of gridded ASCII. 

 
Changes to DMagic:  

• Fixed a bug that prevented the NAVO Chartr Grid file format from 
importing correctly. 

• Improved the importation of gridded ASCII files to make it much 
more robust. 

 
Changes to PFMDirect:  

• Minor fixes and user interface improvements. 
 



Changes to HTFConvert:  
• Removed PFM related options as this functionality is now handled 

using PFMDirect. 



 
Version 5.1   10 June 2002 

 
General Changes: 
 

This is a major new release for the visualization system that incorporates 
numerous new and improved features.  A summary of the major changes 
include: 

• ShiftscapeTM – a new rendering engine for Fledermaus 
• Enhanced turntable mouse interface. 
• Substantially upgraded functionality for PFM editing. 
• Greatly enhanced 3D editor for PFM sounding class. 
• Simplified tools for directly importing data in Fledermaus. 
• Improved 3D point and 3D line class. 
• A redesigned solid model class for Fledermaus. 
• Enhanced file selection dialog. 
• A new 2D route planning application. 
• Etopo2 and other new surface importers for Dmagic. 
• A new graphical tool (PFMDirect) for creating PFM’s. 
• A new color map creation/editing application. 
• Support for depth based color maps. 

 
The file selection dialog has been upgraded to add support for a recently 
used popup that let’s you quickly navigate to recently used directories. 
This is shared among all applications thus if you save a file to a particular 
location in Dmagic then run Fledermaus, that directory will appear in the 
list. On a Windows system, a new popup lets you jump to the different 
disks available on a given system.  

 
Changes to Fledermaus:  
 

The most noticeable changes to the system are in the Fledermaus 
application itself. This includes a new rendering engine called 
ShiftScapeTM that greatly improves the rendering capabilities of 
Fledermaus. ShiftScapeTM automatically degrades the quality of objects 
when exploring to make the best possible use of your graphics hardware. 
All of the visualization types have been upgraded to take advantage of the 
new rendering engine.  
 
The turntable interface includes new functionality including a labeled scale 
bar along the axis that gives the ability to measure vertical and horizontal 
distances directly in the virtual 3D world. The widgets can also show the 
current view compass direction and view angle above the data. 
 



The point editing features of the Fledermaus PFM data object have been 
greatly enhanced with new options to deal with sounding selection and 
surface coloring options. A redesigned and more powerful 3D editor allows 
one to quickly and efficiently edit the sounding (point) data that makes up 
the surface.  

 
Changes to DMagic:  
 

Dmagic now includes a Recent Projects menu under the Project menu. 
New surface import options include an importer for the Etopo2 database 
and the final survey grid format used by Navoceano. Also, the File > 
Import XYZ menu option now launches the Average Gridder application. 
 

New Applications:  
 

      RoutePlanner 
 

This application replaces the existing Routeplanner application with a 
much richer feature set and advanced tools for pipe route planning. It 
takes advantage of Fledermaus’s ShiftScapeTM rendering engine to 
present a detailed visualization of the surface data for route layout. New 
tools allow the interactive route planning with precise controls for route 
parameters such as the radius of curvature for any given segment. 
Profiling tools allow the interactive profiling of data along the route. 
 

      PFMDirect 
 

This graphical application is a support tool for Fledermaus’s PFM editing 
class. It lets you interactively create PFM data sets from a wide variety of 
input point formats including, ASCII, GSF (Generic Sensor Format), HDCS 
(Caris), HTF (Hydrographic Transfer Format), and Shoals (Lidar). It 
provides support tools and the ability to do things such as grid the data via 
avggrid for a quick first look. 
 

      CMapCreate 
 

A graphical application to create and edit color maps for Fledermaus. This 
application supports both the original color maps format and the new 
depth based color maps now available in version 5.1. A powerful 
interactive graphical interface eases the work in building new color maps 
and editing existing ones.  
 
 

 
Version 5.0.3   1 February 2002 

 



General Changes: 
 

This release is primarily a bug fix and minor feature release.  
 
Fledermaus now supports the latest NAVO editor within the PFM class. 

 
Bug fixes: 
 

Improved the X-Window resource files to make sure applications maintain 
a consistent look and feel. Previously some text entry fields didn’t have the 
proper background color to indicate if there were editable or not. 
 
The command line shade program on the UNIX platforms was fixed to 
match the PC version and support was added for draping scalars. 
 
Bug fixes to the tdrextract and tdrappend programs. 
 
The solid model Fledermaus class now reads geo-referencing data 
properly.  
 
The new depth based color maps can be displayed in Fledermaus now. 
 
 

 
Version 5.0.2   13 December 2001 

 
General Changes: 
 

Fledermaus now supports building and editing PFM 4.02 files. 
 
The licensing has been updated to use the latest flexlm libraries. This 
does not affect node-locked licenses, but servers running a network 
license must install a new daemon. Please contact info@ivs.unb.ca for 
more information.  
 
Added a new applet called imagemanip that supports many operations on 
images. 

 
Bug fixes: 
 

Fixed a number of image processing bugs found in Dmagic, resampler, 
quilt, imagemanip, and mktexturedtm. 
 
Cleaned up importing imagery data sets in lat/lon coordinates in Dmagic. 

 



Version 5.0.1   26 October 2001 
 

General Changes: 
 

Added ability to control the screen size or run scripts when switching in or 
out of stereo mode on an SGI. 

 
Bug fixes: 
 

Fixed Device3Dserver on the SGI. 
 
Version 5.0.0   12 October 2001 

 
General Changes: 
 

Version 5.0 includes a number of significant changes to the Fledermaus 
software package. These include: 

• New turntable mouse interface. 
• Enhanced support of image data and Geotiff. 
• Upgraded support for sub-surface data. 
• Expanded import of other data – DXF, Arcview, USGS DEM,  

etc. 
• New PFM sounding data processing and editing object. 
• New internal data types – 3D grid, 3D lines and polygons,  

ROV tracking, and vertical image.  
• Network licensing and improved install procedure.  
• Cross platform – SGI, SUN, and PC (Windows and Linux). 
• New PDF version manual. 

 
Changes to Fledermaus:  
 

The most noticeable change is the new mouse based turntable interface. 
This replaces both the previous 7 widget based turntable interface and the 
mouse flight mode. The 3D flight mode using the Bat remains the same. 
The new mouse interface is based on a centered on view approach to the 
data and requires minimal use of the widget controls. It allows a dynamic 
scaling of the vertical exaggeration of the scene and also allows recording 
of a flight path for use in the movieclient applet.  
 
The modes in Fledermaus have been re-organized to explore, select and 
polygon select. This directly supports the mouse based turntable mode to 
minimize the use of the widgets for exploration and moves the action for 
picking to the left mouse button in both select modes. The new polygon 
select mode allows the digitizing of a line or polygon and saving to a line 
object or ASCII XYZ file.  Profiling is still undertaken with the right mouse 



button, but now generates a line on the surface that remains as the profile 
is moved or the scene explored. 
 
SD objects that are created in Fledermaus during processing can now be 
saved. Recent SD and scene files are stored and listed for easy reload. 
Various data can be imported directly into Fledermaus under import data – 
DXF and Arcview files, ASCII points and line files. A new 3D interaction 
window has been added to provide 2 separate views of the same data.  

 
A number of new internal data objects have been added: 

• 3D grid – with geo-referenced based units may be draped on the 
surface. 

• Vertical image – direct load of image files such as subsurface or 
water column data. 

• 3D lines – in association with the polygon select mode to save 
digitized lines and polygons. 

• ROV object – for display of tracked vehicle. 
• PFM soundings – disk based bin and index format for the process 

and editing of extremely large multi-attribute data such as 
multibeam sonar. 

 
Changes to Dmagic: 
 

Import of a number of data types have been added including: 
• Arcview grid 
• USGS DEM 
• Binary grid 
• ERMapper grid 
• SURF ASCII grid 

 
Surfaces that have been loaded in Dmagic can now be exported as ASCII 
grid, Arcview grid or binary heights.  
 
The surface shader interface has been modified to support some new 
functionality. The direction of the illumination is indicated and a shade 
manager has been added to allow saving and reload of shade parameters. 
 
When assembling objects for Fledermaus the option has been added to 
append a scalar to the SD object. This will allow the scalar value to be 
displayed in Fledermaus in addition to the XYZ of the cursor position. 

 
Changes to Average Gridder: 
 

The following data types are now supported for import: C&C, IVS and STB 
binary, and GSF files. Once scanned data from all formats can be 
exported as ASCII, C&C, STB or IVS binary files. The data can be 



cropped on import by setting the bounds to defined limits. The limits can 
be set either in the visualization window or by entry of coordinates. 
 
The main display uses texture mapping to maintain an image of the data 
during zoom and pan. The level of the texture mapping will depend on 
each platform and can be varied to suit or the image turned off during 
zoom or pan. 
 
Three types of gridded surfaces can now be produced; weighted average, 
median filter or shallow bias.  

 
Miscellaneous: 
 

A number of new of applets have been added to support import of data 
from other applications including: 

• arcconvert – for Arcview project files. 
• dxfexplore – for DXF drawing files 

 
Licensing has been extended to network multi-user licenses, and these 
can be across different platforms (SGI, Sun and PC) on the same network. 
 
The reference manual has been re-written and is now distributed as a 
PDF file that can be started from the Help menu. Updates will also be 
distributed via the support section of the IVS web site. 


